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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

MICREX-F Series SIO Driver

In this manual, the connection procedure will be described by following the below sections:

1

System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

& System Configuration” (page 3)

Selection of External Device

Select a model (series) of the External
Device to be connected and connection
method.

"2 Selection of External Device" (page 7)

Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

! Example of Communication Setting"
(page 8)

Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro Ex or in offline mode.

E vy Setup Items" (page 24)

\

Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

75 Cable Diagram" (page 29)

A

Operation
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1 System Configuration

MICREX-F Series SIO Driver

The system configuration in the case when the External Device of Fuji Electric Co.,Ltd. and the Display are

connected is shown.

_ _ Setting Example Cable
Series CPU Link I/F SIO Type .
File Switch Diagram
. Setting Setting Cable
cl?:IZ:?:ZUClerE)t;rface RS232C Example 1 Example 2 Diagram 1
F80H (page 8) (page 11) (page 29)
F120H - -
F250 | Redgsinterface | RS422/dg5 | Sciind Setting Cable
on EFU120B (4wire) Example 3 Example 4 Diagram 2
(page 13) (page 16) (page 32)
F30 ™1 . Setting Setting Cable
F50 1 Sr]siiiilzrgzrféi% RS232C Example 1 | Example5 | Diagram 1
F60 (page 8) (page 18) (page 29)
F70
MICREX-F | F70S RS485 interface | RS422/485 gi;t::gle 5 gig::gle 6 giaab'fam )
F80 on FFK120A-C10 | (4wire) P P g
F80H (page 13) (page 20) (page 32)
F81
F120 _
F120H Setting Cable
F120S FFK100A-C10 *2 RS232C - Example 7 Diagram 3
F200 (page 22) (page 42)
F250
£70 Setting Setting Cable
£70S NC1L-RS2"2 ™3 RS232C Example 1 | Example 2 | Diagram 4
(page 8) (page 11) (page 43)

*1  When you use F30 or F50 for T link connection, T link master adaptor (FTM050A) is necessary.
*2  You cannot use FFK100A-C10 or NC1L-RS2 in 1:n configuration.

*3  When you install 2 link units on the extension base unit created by T link function based on the basic base
unit of the External Device, you can connect the Display on either of 2 link units (simultaneous connection
on both 2 link units are not available). When you install 2 basic base units, simultaneous connection on both
2 link units are available.

B Connection Configuration

¢ RS232C

¢ 1:1 Connection

Display

External Device

(

]

)

/Operation mode:1

RS232C
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MICREX-F Series SIO Driver

e 1:n Connection
Display

RS232C RS422/485 (4wire) RS422/485 (4wire)

External Device / \
External Device* External Device*

1 ] 1 ] 1 ]

J J J J J J

Operation mode:3

Operation mode:2 Operation mode:3

N— _

—
Max 16 units

*  Turn ON the termination resistance switch on the interface which terminates the RS422 connection.

@ RS422/485 (4wire)
e 1:1 Connection
Display

External Device*

il

/Operation mode:3

RS422/485 (4wire)

*  Turn ON the termination resistance switch on the External Device interface.
¢ 1:n Connection

RS422/485 (4wire) RS422/485 (4wire) RS422/485 (4wire)

/ External Device External Device External Device*

Display

]

|

J

Operation mode:3

S~—_

1

]

J

J

1

]

J

J

Operation mode:3

Operation mode:3

U

—
Max 16 units

*  Turn ON the termination resistance switch on the interface which terminates the RS422 connection.
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H |PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

MICREX-F Series SIO Driver

Usable port
; Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)
com1™, comz,
PS-2000B ComM3™L Coma - -
PS-3450A, PS-3451A, % qx %
PS3000-BA, PS3001-BD COML, COM2 com2 comz
PS-3650A (T41 model), “q ] ]
PS-3651A (T41 model) coml
PS-3650A (T42 model), %2 1% i
PS-3651A (T42 model) com1™t"2 com2 CcCoMm1 ComM1
PS-3700A (Pentium®4-M) | COM1™, com2™, 2 o
PS-3710A COM3™2  coM4 COM3 coms
PS-3711A com1™, com2™ COM2*? COM2*2
PS40003 COM1, COM2 - -
com1™2 com2™, w10 %
PL3000 COM3, COM4 COM1 ComM1

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.
*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

DIP Switch setting: RS-232C

DIP Switch Setting Description
1 OFF™ Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

GP-Pro EX Device/PLC Connection Manual 5



MICREX-F Series SIO Driver

DIP Switch setting: RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON
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MICREX-F Series SIO Driver

2 Selection of External Device

Select the External Device to be connected to the Display.

,j_i': Welcome to GP-Pro EX B

GP-Pro E 7’ - Device/FLE
A
Hurmber of Devices/PLCs |1 3: g

Device/PLE 1

Manufacturer | Fuiji Electric Co. Ltd. |L
Series MICREXF Series 510 E
Fot COM1 [l

Beter to the marnual of this DevicePLC

Recent Device/PLC
4 3

I~ Use System Area Device Infarmation
£iim

QY

Back (B] Communication Settings Mew Logic | Mew Screen I Canicel

Setup Items Setup Description
Number of Devices/ Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the
PLCs display.
Manufacturer Select the manufacturer of the External Device to connect. Select "Fuji Electric Co.,Ltd.".
Select the External Device model (series) and the connection method. Select "MICREX-F
Series SIO".
Series In System configuration, make sure the External Device you are connecting is supported by

"MICREX-F Series SIO".
& System Configuration” (page 3)

Port Select the Display port to be connected to the External Device.

Check this option to synchronize the system data area of the Display and the device
(memory) of the External Device. When synchronized, you can use the External Device’s
ladder program to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System

Area] Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

Use System Area

GP-Pro EX Device/PLC Connection Manual 7



MICREX-F Series SIO Driver
|

3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are
shown.
When you use the MICREX-F Series, use GP-Pro EX and the ladder software to set as below.
3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

GP-Pro EX Device/PLC Connection Manual 8



MICREX-F Series SIO Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings |
FLC1

Station Mo,

IU =
Drefault |
oK@ | Cancel |

B Setting of External Device
(1) Turn OFF the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module
of the External Device. Other settings are not necessary. The DIP switch setting will be effective after restart.
Use the rotary switch for MODE setting.

Z
©

Setup ltems Setup Description

No need

No need

No need

No need Unused

No need

No need

No need

QO N| O O | W N|

OFF Initial file setting effective

(2) Set the mode switch key of the External Device body to [TERM].
(3) Startup the ladder software. Execute [New File] from the [File] menu.

(4) Select the model of the External Device to use.
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MICREX-F Series SIO Driver

(5) Create the default file in the data table. Please refer to the manual of the External Device for the default file
number or the setting method. When you select MODE?2 or 3, use the rotary switch to specify the same
number as the station No. in the device setting. The setting is not necessary for MODE1 (RS232C 1:1
connection). Please refer to the connection configuration diagrams for more details.

Setup ltems Setup Description Notes
MODE switch Depending on connection type
Set by the rotary switch
Station No. Depending on connection type
Transmission Procedure | No procedure
Mode Settings
Baud rate 19200
Data Bit 7
Parity Bit Even
Stop Bit 2
DCE/DTE DCE
CTS/RTS Always ON
DSR/DTR Always ON
Set by the initial file
Send Condition None
PK Access Enable
Transmission Code JIS
Code Conversion Enable
Head Code STX
End Code ETX
Head Code 1, 2 0
End Code 1, 2 0
BCC None

(6) Select [Transfer] from the [File] menu to transfer to the External Device body.

(7) After the transfer is completed, restart the External Device.

GP-Pro EX Device/PLC Connection Manual 10



MICREX-F Series SIO Driver
|

3.2 Setting Example 2
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 11



MICREX-F Series SIO Driver

B Setting of External Device
Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the
External Device. When you perform the settings with the switch, the head code, end code and send condition will
be fixed. Use the rotary switch for MODE setting. When you select MODE?2 or 3, use the rotary switch to specify
the same number as the station No. in the device setting. The setting is not necessary for MODE1 (RS232C 1:1

connection). Please refer to the connection configuration diagrams for more details.

No. Setup ltems Setup Description

1 OFF

2 ON Baud rate = 19200

3 ON

4 OFF Stop bit length = 2

5 ON Data bit length = 7

6 ON Parity bit = Even

7 ON Parity bit = Enable

8 ON Switch setting effective

Setup ltems Setup Description Notes
MODE switch Eoer'?:’e”g:gg tc;r;)e

- Set by the rotary switch

Station No. S:r?r?;g:gg ?yr;Je
Send Condition None
Head Code : Fixed
End Code CRI/LF
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MICREX-F Series SIO Driver
|

3.3 Setting Example 3
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

o iii o Tiie e
dagaapas

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 13



MICREX-F Series SIO Driver

B Setting of External Device
(1) Turn OFF the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module
of the External Device. Other settings are not necessary. The DIP switch setting will be effective after restart.
Use the rotary switch for MODE setting.

No. Setup ltems Setup Description

No need

No need

No need

No need Unused

No need

No need

No need

Wl N| O O A W| N[ =

OFF Initial file setting effective

(2) Set the mode switch key of the External Device body to [TERM].
(3) Startup the ladder software. Execute [New File] from the [File] menu.

(4) Select the model of the External Device to use.
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MICREX-F Series SIO Driver

(5) Create the default file in the data table. Please refer to the manual of the External Device for the default file
number or the setting method.
Use the rotary switch to specify the same number as the station No. in the device setting. Please refer to the

connection configuration diagrams for more details.

Setup Items Setup Description Notes
MODE switch 3
Set by the rotary switch
Station No. Depending on connection type
Transmission Procedure | No procedure
Mode Settings
Baud rate 19200
Data Bit 7
Parity Bit Even
Stop Bit 2
DCE/DTE DCE
CTS/RTS Always ON
DSR/DTR Always ON
Set by the initial file
Send Condition None
PK Access Enable
Transmission Code JIS
Code Conversion Enable
Head Code STX
End Code ETX
Head Code 1, 2 0
End Code 1, 2 0
BCC None

(6) Select [Transfer] from the [File] menu to transfer to the External Device body.

(7) After the transfer is completed, restart the External Device.
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MICREX-F Series SIO Driver
|

3.4 Setting Example 4
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

e f [

. iii o Tie e
\ﬂ

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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MICREX-F Series SIO Driver

B Setting of External Device
Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the
External Device. When you perform the settings with the switch, the head code, end code and send condition will
be fixed. Use the rotary switch for MODE setting. Use the rotary switch to specify the same number as the station

No. in the device setting. Please refer to the connection configuration diagrams for more details.

No. Setup ltems Setup Description

1 OFF

2 ON Baud rate = 19200

3 ON

4 OFF Stop bit length = 2

5 ON Data bit length = 7

6 ON Parity bit = Even

7 ON Parity bit = Enable

8 ON Switch setting effective

Setup Items Setup Description Notes
MODE switch 3
Station No. S:r?neggggg ?yr;) . Set by the rotary switch
Send Condition None
Head Code : Fixed
End Code CRI/LF
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MICREX-F Series SIO Driver
|

3.5 Setting Example 5
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

(s

ii 22

e f [

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 18



MICREX-F Series SIO Driver

B Setting of External Device
Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the
External Device. When you perform the settings with the switch, the head code, end code and send condition will
be fixed. Use the rotary switch for MODE setting. When you select MODE?2 or 3, use the rotary switch to specify
the same number as the station No. in the device setting. The setting is not necessary for MODE1 (RS232C 1:1
connection). Please refer to the connection configuration diagrams for more details.

@ Settings of Character Configuration Switch

No. Setup ltems Setup Description
1 OFF
2 OFF Unused
3 OFF
4 OFF Stop bit length = 2
5 ON Data bit length = 7
6 ON Parity bit = Even
7 ON Parity bit = Enable
8 ON Switch setting effective

@ Baud Rate Setting Switch

No. Setup ltems Setup Description
1 OFF
2 OFF
3 OFF
Always set to OFF.
4 OFF
5 OFF
6 OFF
7 ON Baud rate = 19200
8 OFF Unused
Setup Items Setup Description Notes
MODE switch Depending on
connection type
. Set by the rotary switch
Station No. Depend!ng on
connection type
Send Condition None
Head Code : Fixed
End Code CRI/LF
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MICREX-F Series SIO Driver
|

3.6 Setting Example 6
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

e f [

. iii o Tie e
\ﬂ

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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MICREX-F Series SIO Driver

B Setting of External Device
Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the
External Device. When you perform the settings with the switch, the head code, end code and send condition will
be fixed. Use the rotary switch for MODE setting. Use the rotary switch to specify the same number as the station

No. in the device setting. Please refer to the connection configuration diagrams for more details.

@ Settings of Character Configuration Switch

No. Setup ltems Setup Description
1 OFF
2 OFF Unused
3 OFF
4 OFF Stop bit length = 2
5 ON Data bit length = 7
6 ON Parity bit = Even
7 ON Parity bit = Enable
8 ON Switch setting effective

€ Baud Rate Setting Switch

No. Setup ltems Setup Description
1 OFF
2 OFF
3 OFF
Always set to OFF.
4 OFF
5 OFF
6 OFF
7 ON Baud rate = 19200
8 OFF Unused
Setup ltems Setup Description Notes
MODE switch 3
Station No. S:r?f:(g:gg ?yr;)e Set by the rotary switch
Send Condition None
Head Code : Fixed
End Code CRI/LF
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MICREX-F Series SIO Driver
|

3.7 Setting Example 7
B Settings of GP-Pro EX

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

(s

ii 22

e f [

) i
\ﬂ

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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MICREX-F Series SIO Driver

B Setting of External Device

Perform the communication settings of the External Device in the default file. Create the default file in the data
table. Please refer to the manual of the External Device for the default file number or the setting method.

Setup Items Setup Description Notes
Transmission Procedure | No procedure
Mode Settings
Baud rate 9600
Data Bit 7
Parity Bit Even
Stop Bit 2
DCE/DTE DCE
CTS/IRTS Always ON
DSR/DTR Always ON
Send Condition None Set by the initial file
PK Access Disabled
Transmission Code JIS
Code Conversion Enable
Head Code STX
End Code ETX
BCC None
Position TEXT
Formula Sum
Code Transmission Code

GP-Pro EX Device/PLC Connection Manual 23




4 Setup Items

MICREX-F Series SIO Driver

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

Fng Example of Communication Setting" (page 8)

4.1 Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |

Summary

Change Device/PLC

M anufacturer IFuii Electric Co. Ltd. Series MICREX-F Seriez 510

Text Data Mode I‘I_ Change

Communication Settings

SI0 Type &+ R5232C  R5422/485(2wire)

e 7 8

= MOME f* EVEM

- e 2

= MOME & ER[DTR/CTS)

|3 3: [z2c]
| 2 32
|D 3: [mz]

@ STH/ETH O /CRsLF

7 R5422/455 wire]
Speed

[rata Length
Parity  0oD
Stop Bit
Flaws Control 7 HOMA=OFF
Timeaut
Fietry

Wwait To Send

Start / End Code

Rl /%CC & Rl & WET

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C

Isolation Unit, please select it to WCC. Default

Device-Specific Settings

Alloweable Mumber
of Devices/PLCs 16

Add Device

Mo, Device Mame

[&] 1 Jrc

Settings

E IStation Mo.=0

Fart  |COM1

Add Indirect
Device

Setup Items

Setup Description

SIO Type

Select the S10 type to communicate with the External Device.

Speed

Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.

Continues to the next page.

GP-Pro EX Device/PLC Connection Manual
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MICREX-F Series SIO Driver

Setup Items Setup Description

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

Wait To Send packets to transmitting next commands.

Start/End Code Select the start/end code for data.

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE  Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

B Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] Ef: .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings [ x|
FLC1

Station Mo

[0 =
Default |
ok@ | cencel |

Setup Items Setup Description

Station No. Enter a station number of the External Device, using 0 to 99.

GP-Pro EX Device/PLC Connection Manual 25




MICREX-F Series SIO Driver

4.2 Setup Items in Offline Mode

NOTE | * Referto the Maintenance/Troubleshooting guide for information on how to enter offline mode or

Cf.

about the operation.

Maintenance/Troubleshooting Guide "Offline Mode"

» The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

Cornm, Device Option

MICREX-F Series S10 [GOML] Page 1/1
SI0 Type |RS232C =
Speed | 19200 1|
Data Length e g
Parity NONE * EVEN opo
Stop Bit 1 . 7
Flow Gontrol [ER(DTR/GTS) |
Timeout{s) 3w | a
Retry 7 w | oA
Wait To Send{ms) v a
Start / EndCode JSTR / ETk 5|
; 20m5 /09,12
| Erit | Beck 13:20:58
Setup Items Setup Description
Select the S10 type to communicate with the External Device.
IMPORTANT |
To make the communication settings correctly, confirm the serial interface specifications of
SIO Type Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display
unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and
Flow Control

reception data.

Continues to the next page.
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MICREX-F Series SIO Driver

Setup Items Setup Description
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout (s) .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.

Wait To Send (ms)

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.

Start/End Code

Select the start/end code for data.

B Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device].

(o, Device Option
MICREX-F Series SI0 [CoML] Page 1/1
Device/PLC Hame [PLCT ==
Station No. [ ilw a
7 2005/09/02
R ook 13:21:68

Setup ltems

Setup Description

Device/PLC Name

Select the External Device for device setting. Device name is a title of External Device set
with GP-Pro EX.(Initial value [PLC1])

Station No.

Enter a station number of the External Device, using 0 to 99.
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MICREX-F Series SIO Driver

W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Option].

Cornm, Device Option

MICRER-F Series $I0 [CoML] Page 1/1

RI /MGG e RI VGG
In the case of RS232C, vou can select
the 9th pin to RIInput) or YCO{HY
Power Supplu). I wou use the Digital’s
RS2320 Isolation Unit, please select
it to VGO,

Exit Back

Setup Items Setup Description
Switch the 9th pin setting when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.
NOTE I * GP-4*01TM do not have the [Option] setting in the offline mode.
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5 Cable Diagram

MICREX-F Series SIO Driver

The cable diagram shown below may be different from the cable diagram recommended by Fuji Electric Co.,Ltd.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

e The FG pin of the External Device body must be D-class grounded. Please refer to the manual of the External

Device for more details.

¢ SG and FG are connected inside the Display. When connecting SG to the External Device, design the system

not to form short-circuit loop.

* Connect the isolation unit, when communication is not stabilized under the influence of a noise etc.

Cable Diagram 1

Dlsp_lay Cable Notes
(Connection Port)

GP3000 (COM1) RS232C cable
GP4000"! (CoM1) 1A by Pro-face For 1:1 connection, set the operation mode on
SP5000 (COM1/2) CA3-CBL232/5M-01 (5m) the interface to 1. For 1:n connection, set the
ST (COM1) operation mode for the External Device
LT3000 (COM1) connected to the Display with RS232C to 2,
IPC™? 1B Your own cable and for other Devices to 3.
PC/AT

*1  All GP4000 models except GP-4100 Series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.

H |[PC COM Port (page 5)
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MICREX-F Series SIO Driver

1A)
¢ 1:1 Connection

Display

External Device*
CA3-CBL232/5M-01 :ﬂ £ ]
RS232C

Set the operation mode on the External Device interface to 1.

*

e 1:nconnection

RS422 port on Link I/F Shield RS422 port on Link I/F

Signal ! N Signal

name ! /\ :'.I name
Display RDA [¢ : SDA

RS232 port on Link I/F / \

CA3-CBL232/5M-01 ( ) RDB - SDB
l J SDA //\\ ™ RDA

RS232C SDB > RDB

SG ‘. H SG

e

A
\ 4

Your own cable (RS422 (4wire))

NOTE | ¢ Turn ON the termination resistance switch on the External Device which terminates the RS422
connection.

* For the 1st External Device connected with RS232C and RS422, set the operation mode on the
Link I/F to 2. For the following External Devices connected with RS422, set it to 3.
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MICREX-F Series SIO Driver

1B)
¢ 1:1 Connection

External Device*

D-sub 9 pin (socket) Shield D-sub 25 pin (plug)
. Signal roTTTTT -:". Pi Signal
Pin name ‘: i in name
H "
1 [ ¢D ‘\ i— 1 | FG
h V)
Display 2 RD [« \ : 2 sSD
1
3 SD \C 3 RD
4 | ER | i 4 | RTS
)
o SG [N : 5 | cTS
: 6
7 RS — \L DSR
8 CS P 7 | sG
L 8 | cp
)
S b 20 | ER
*  Set the operation mode on the External Device interface to 1.
¢ 1:n Connection
External Device*1*2
RS232 port on Link I/F
D-sub 9 pin (socket) Shield D-sub 25 pin (plug)
O = i Pin | Sigral RS422 (4wire)
1 CDh ‘:\ it 1 FG RS422 port on Link I/F  Shield External Device*1*3
Display 2 | RO ¢ 2 | sp S ] S A S
3 SD » 3 RD ) RDA [¢ /A\ o SDA
4 ER [ — 4 RTS RDB [* SDB
. —\\ S | J /\
SG \ CTS SDA / \ ™ RDA
7 - [: 6 »
RS N DSR SbB . ¥ RDB
e los |+ N L | sc SIS H sG
\ 8 | cp oo L
[ u 20 | gr

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 2.
*3  Set the operation mode on the External Device interface to 3.
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Cable Diagram 2

MICREX-F Series SIO Driver

Display
(Connection Port)

Cable

Notes

GP3000"! (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST (coMm2)
LT3000 (COM1)
IPC™3

2A

RS422 cable by Pro-face
CA3-CBL422/5M-01 (5m)

2B

COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
+
Your own cable

2C

COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
422 cable for GP by Pro-face
CA3-CBL422-01 (5m)

2D

Your own cable

GP3000" (COM2)

2E

Online adapter by Pro-face
CA4-ADPONL-01
+
Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
+
Your own cable

2F

Online adapter by Pro-face
CA4-ADPONL-01
+
422 cable by Pro-face
CA3-CBL422-01 (5m)

2G

Online adapter by Pro-face
CA4-ADPONL-01
+

Your own cable

GP4000™ (COM?2)
GP-4201T (COM1)
SP5000 (COM1/2)

2H

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1"®
+

Your own cable

2A

RS422 cable by Pro-face
CA3-CBL422/5M-01 (5m)

2C

COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
422 cable for GP by Pro-face
CA3-CBL422-01 (5m)

2D

Your own cable

Turn ON the
termination resistance
switch on the External
Device which
terminates the RS422
connection.

Set the operation
MODE
to 3.

*1  All GP models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B

GP-Pro EX Device/PLC Connection Manual 32




*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

‘5" m |PC COM Port (page 5)

*4  All GP models except GP-3200 series and AGP-3302B
*5  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T
*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block

Conversion Adapter, refer to Cable Diagram 2B.

MICREX-F Series SIO Driver
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MICREX-F Series SIO Driver
|

2A)
¢ 1:1 Connection

External Device*

Signal name Signal name
Display RDA < SDA
CA3-CBL422/5M-01 RDB [« SDB
SDA > RDA
SDB > RDB
SG SG
FG FG

*Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

¢ 1:n Connection

External Device*2 Shield External Device*1*2
Signal name Signal name ',' ','" Signal name

Display RDA |¢ SDA le———A+ T spa
CA3-CBL422/5M-01 RDB e SDB |« ' / \' I SDB
SDA RDA A » RDA

SDB » RDB / \ » RDB

SG SG : + ,' SG

FG FG |", ‘I",’:_ FG

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2B)
e 1:1 Connection
Terminal block Shield External Device™
Signal name '-"_ '-'A'nl Signal name]
Display RDA |« ,: A .” SDA
CA3-ADPTRM-01 RDB_ le E / \E SDB
[D] | B SDA A » RDA
SDB / \ » RDB
/f TERM | | i SG
CA3-ADPCOM-01 SG N T Fo

\ 4

A

Your own cable

*  Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

¢ 1:n Connection

Terminal block Shield External Device*2 ~ Shield External Device*1*2
Signal name -"’ ",’\III Signal name ,'"- _______ ?'-' Signal namg

Display RDA fe—— A SDA A} SDA
CA3-ADPTRM-01 RDB |e / \ SDB < / \ SDB

[D] [ =] SDA A » RDA A » RDA

SDB / \ » RDB / \ » RDB

/ TERM SG ' ' SG
CA3-ADPCOM-01 SG G L ¥ I Fa

\4

A

Your own cable

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.

*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2C)
¢ 1:1 Connection

External Device*

Signal name W
Display RDA e SDA
CA3-CBL422-01 RDB (e SDB
il SDA » RDA
SDB » RDB
/ SG SG

CA3-ADPCOM-01

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.
* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

¢ 1:n Connection

External Device*2 Shield External Device*1*2
Signal name Signal name] '-' 'r'“" Signal name]

Display RDA |« SDA |e—i—A 1 SDA
CA3-CBL422-01 RDB |« SDB |« \ SDB

[D] SDA » RDA A » RDA

SDB » RDB / \ » RDB

/ SG SG ‘.‘ ': : SG
CA3-ADPCOM-01 Veeeee—1 FG

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.
*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2D)
¢ 1:1 Connection

D-sub 9 pin (socket) Shield External Device*
Termination ) Signal T n Signal
resistance Pin name h i name
100Q 1W POA
{ T | RDA 71 SDA
Display 2 RDB 1 ; ; SDB
3 | spA ——A—H— roa
7 | spB — =" RDB
5 | sG SG
4 | ERA :I O e
8 CSA
9 ERB :I
6 CSB

*  Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

1:n Connection

D-sub 9 pin (socket) Shield External Device*2 Shield External Device*1*2
Termination Pi Signal i " Signal ;T n Signal
resistance in name ! h name | I name
100Q 1W POA POA
{ 1 | RDA |« :/\fi SDA [ /\ SDA
- 2 | RDB |« — SDB [+ i SDB
isplay
3 | sbA /\\ » RDA /\ » RDA
7 | sbB ——> RDB : > RDB
5 | sG -.‘ G sG
4 | ERA :I b — FG oo — G
8 | csA
9 | ERB :I
6 |csB

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2E)
» 1:1 Connection
Terminal block Shield External Device*
Signal name {> ﬁ Signal name
Display RDA |« ."I A :: I: SDA
CA3-ADPTRM-01 [ RDB  le—ert / \ L SDB
[D] | = SDA A > RDA
SDB !. / \ »| RDB
/ TERM L SG
CA4-ADPONL-01 sG e VI =T

v

A

Your own cable

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

¢ 1:n Connection

Terminal block Shield External Device*2 Shield External Device*1*2
Signal name] ST ,"\', Signal namgj | .""". Signal nam
l' l' ! ] [}
Display RDA AN SDA |¢ //\\ ! SDA

A
~
A

CA3-ADPTRM-01 [~ oo SDB SDB

ﬂ]] [ =] [soa /\\ »| RDA //\\ RDA

SDB » RDB » RDB
/ TERM SG SG

CA4-ADPONL-01 sSG FG | SRR -—— FG

A

A

v

A

Your own cable

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.

*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2F)
¢ 1:1 Connection

External Device*

Signal name Signal nam¢g
Display RDA |« SDA
CA3-CBL422-01 RDB |« SDB
[D] i SDA » RDA
SDB » RDB
/ SG SG

CA4-ADPONL-01

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.
*  Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

¢ 1:n Connection

External Device*2 External Device*1*2
Signal name Signal name ':'r ."""- Signal name|

Display RDA |« SDA |e— //\\ i SDA
CA3-CBL422-01 RDB (e SDB [« SDB

00 SDA » RDA A » RDA

SDB » RDB / \ » RDB
/ & o I
CA4-ADPONL-01 N T Fo

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.
*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.

*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2G)
¢ 1:1 Connection

D-sub 9 pin (plug) Shield External Device*

Pin Signal name ;"""““-"'"‘.l Signal name
Display 2 RDA je——A SDA
7 RDB (¢ /\ SDB
D 3 | spA A+ RrDA
/ 8 SDB / \_,_._, RDB
CA4-ADPONL-01 5 SG |‘.‘ '-,‘ ','I SG
1 TERMRX |— ‘eeceeeee- " S FG

*  Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

1:n Connection

D-sub 9 pin (plug) Shield External Device*2  Shield External Device*1*2
Pin [Signalname| | ,.‘"'. Signal name| | '."‘-,. Signal namd
Display > | RoA je—i—A i SDA fJe——AH SDA
7 RDB | / \ SDB |« / \ SDB
[D] 3 SDA A »| RDA A »| RDA
/‘ 8 SDB / \ »| RDB / \ » RDB
5 SG : = SG . — SG
CA4-ADEONLOT T TERVRX | ‘e i T FG [ [ =

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 3.
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MICREX-F Series SIO Driver

2H)
e 1:1 Connection
Terminal block Shield External Device*
Signal name ,’r '.'"-' Signal name
Display RDA e 5 A .“ SDA
=08 Jeqi/ \L 508
= SDA A » RDA
SDB / \ » RDB
PFXZCBADTM1 TERM | | 5 SG
SG T\ [ Fo

v

A

Your own cable

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

e 1:n Connection

Terminal block Shield External Device*2  Shield External Device*1*2
Signal name ;‘r I"A'II Signal name ,"’- ------- ;’n‘l. Signal namg
Display RDA |le—i. //\\ i SDA le—i //\\ & SDA
RDB |« SDB |« SDB
= SDA //\\ RDA //\\ »| RDA
SDB » RDB » RDB

SG

PFXZCBADTM1 TERM |} : SG :
SG _/()/—_““_ FG [— — FG

Your own cable

\ 4

A

*1  Turn ON the termination resistance switch on the External Device which terminates the RS422 connection.
*2  Set the operation mode on the External Device interface to 3.
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Cable Diagram 3

MICREX-F Series SIO Driver

Display
(Connection Port)

Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1) 3A
LT3000 (COM1)
IPC™?

PC/AT

Your own cable

*1  All GP4000 models except GP-4100 Series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.

‘5" m |PC COM Port (page 5)

3A)

External Device*

D-sub 9 pin (socket) Shild Pin Snigrr:]a(lel

Pn | S8 | h Bl | FG

Display 2 RD :: ;: ". » B2 SD
3 | sp [ H— B3 | RD

4 | ErR [ He B5 | cTs

°> | sc \ B6 | DSR

" | rs T B7 | sG

8 | cs Q B8 | cp

: tt A4 | ER

l—

-

*  Set the operation mode on the External Device interface to 1.

GP-Pro EX Device/PLC Connection Manual

42




MICREX-F Series SIO Driver

Cable Diagram 4

Displa
p_ y Cable Notes
(Connection Port)
GP3000 (COM1) 4A RS232C cable by Pro-face
GP4000"! (COM1) CA3-CBL232/5M-01 (5m)
SP5000 (COM1/2) Set the operation mode
ST (COM1) on the interface to 1
LT39200 (Comy) 4B Your own cable
IPC
PC/AT

*1  All GP4000 models except GP-4100 Series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
H |[PC COM Port (page 5)

4A)

Display
External Device*

( ]

CA3-CBL232/5M-01 :ﬂ
q IE;: T |
RS232C l J

*  Set the operation mode on the External Device interface to 1.

4B)

External Device*
D-sub 9 pin (socket)

Shield D-sub 25 pin (plug)
Pin S | R [ e | e
1 | oo [\ i— 1 | ro
Display - RD ; ' 2 SD

3 | sp s 3 | RD
4 | ER 4 | RTS
5 | sG 5 | cTs
7 RS 6 | psr
8 CS 7 SG

8 CD

20 | Er

*  Set the operation mode on the External Device interface to 1.
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MICREX-F Series SIO Driver

6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of

your connecting equipment.

This address can be specified as system data area.

Device Bit Address Word Address 32bits Notes

Input Relay B00000 - BO511F WB0000 - WB0511 "1

Direct I/O W24.0000 - W24.0159 9]

Auxiliary Relay M00000 - MO511F WMO0000 - WMO0511 1

Keep Relay K00000 - K0063F WKO0000 - WK0063 1

Differential Relay D00000 - DO063F WDO0000 - WD0063 12

Link Relay L.00000 - LO511F WL0000 - WL0511 "1

Special Relay F00000 - F4095F WF0000 - WF4095 172

Announce Relay A00000 - A4095F WA0000 - WA4095 12

Timer 0.01 sec. TOO000 - TO511 ---

Timer 0.1 sec. T0512 - T1023 -

Counter C0000 - C0255

Timer 0.01 sec. (Current Value) TRO000 - TRO511 HIL

Timer 0.01 sec. (Setting Value) TS0000 - TS0511

Timer 0.1 sec. (Current Value) W9.0000 - W9.0511

Counter (Current Value) - CR0000 - CR0255

Counter (Setting Value) - CS0000 - CS0255
BD0000 - BD4095 .3l

Data Memory D10000 - DI4095 e .3
S10000 - S14095 k|
W30.0000 - W30.4094 LS
W31.0000 - W31.4094 el

File Memory W32.0000 - W32.4094 )™
W33.0000 - W33.4094 Eal™
W34.0000 - W34.4094 3™
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*1  The highest bit in the word device corresponds to the bit 0 in the bit device. The lowest bit in the word device
corresponds to the bit F in the bit device.
<Example> When writing Hex data "0001" in the address WB0002 (word device)

B002* (bit device) 0 1 2 3 4 5 6 7 8 9 A B C D E F

WBO0002 (word device) o;j0ojo0jo0ojofojojojo0ojojfojofojoj|o0 |1

*2  Write disable
*3  Always use in 16-bit data by user definition.
*4  Always use in 32-bit data by user definition.

NOTE | ¢ Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. "GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
« Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

GP-Pro EX Device/PLC Connection Manual 45



7 Device Code and Address Code

MICREX-F Series SIO Driver

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

Device Code

Device Device Name (HEX) Address Code

Input Relay B 0080 Word Address
Direct 1/O W24. 0015 Word Address
Auxiliary Relay M 0081 Word Address
Keep Relay K 0084 Word Address
Differential Relay D 0083 Word Address
Link Relay L 0088 Word Address
Special Relay F 0082 Word Address
Announce Relay A 0085 Word Address
Timer 0.01 sec. (Current Value) TR 0062 Word Address
Timer 0.01 sec. (Setting Value) TS 0065 Word Address
Timer 0.1 sec. (Current Value) Wo. 0063 Word Address
Counter (Current Value) CR 0061 Word Address
Counter (Setting Value) CSs 0064 Word Address
BD 0000 Word Address

Data Memory DI 0001 Word Address
Sl 0002 Word Address

W30. 0010 Word Address

W3L. 0011 Word Address

File Memory W32. 0012 Word Address
Wa33. 0013 Word Address

W34, 0014 Word Address

GP-Pro EX Device/PLC Connection Manual
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MICREX-F Series SIO Driver

8 Error Messages
Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error
Occurrence Area)". Each description is shown below.
Item Description
No. Error No.

Device Name

Name of External Device where error occurs. Device name is a title of External Device set
with GP-Pro EX. (Initial value [PLCL1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

 IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
 Device address is diplayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAAOQ35: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE | * Refer to your External Device manual for details on received error codes.
» Refer to "Display-related errors™ in "Maintenance/Troubleshooting Guide" for details on the error

messages common to the driver.
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|
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